
IJFANS INTERNATIONAL JOURNAL OF FOOD AND NUTRITIONAL SCIENCES 

ISSN PRINT 2319 1775 Online 2320 7876 

Research paper© 2012 IJFANS. All Rights Reserved, Journal Volume 10, Iss 10, 2021 

397 
 

IOT BASED PATIENT HEALTH MONITORING SYSTEM 

USING MEDI-ROBOT 
1
B.Venkateswramma,

2
D.Surendra,

3
P Jyothi Prakash Reddy,

4
Bhumireddy Pallavi 

1,2,3
Assistant Professor,

4
Student 

Department of ECE 

Gouthami Institute Of Technology & Management For Women, Proddatur, Ysr Kadapa, A.P 

 

ABSTRACT: 

In this project, we propose a robot named Medi-Robot with some functionality of providing 

medicine as well as to measure the vital parameters (Heart rate and Temperature) of the 

patient. During the current scenario, reducing the human to human contact in hospitals is 

required. In a bid to prevent doctors and medical staff from getting affected by Corona virus 

the role of medicine delivering robots are evolving. We can attain the locomotion procedure 

of the robot using the principle of Radio-frequency identification (RFID) that automatically 

identifies and tracks tags attached to the objects. The movement and finding the path to 

patient location is done through with Bluetooth module to navigate the robot and with RFID 

tag. To navigate the robot by the help of Bluetooth module and give the commands from the 

mobile like forward, backward, left, right, stop commands. The robot will move towards the 

patient's room by following user commands and use RFID cards to identify the patient's room 

number. Using the vending machine the medicine delivery is made possible to the patients. 

All the measured parameters will be stored to the cloud using the application of the Internet 

of Things (IoT). All the data will successfully be sent to the cloud through the Node MCU.  

Keywords: Bluetooth module, Heart rate sensor, Microcontroller, Internet of Things (IoT), 

Radio-frequency identification (RFID). 

INTRODUCTION 

An embedded device is a machine which is 

going to do a predefined exact undertaking 

is the embedded system and is even 

defined as combination of each software 

program and hardware. A trendy-reason 

definition of embedded structures is that 

they're devices used to manipulate, reveal 

or assist the operation of device, 

machinery or plant. "Embedded" reflects 

the truth that they're an quintessential a 

part of the system. At the opposite severe a 

preferred-purpose laptop can be used to 

govern the operation of a massive complex 

processing plant, and its presence will be 

obvious.  

                            All embedded 

systems are which include computer 

systems or microprocessors. Some of 

those laptop systems are but pretty 

easy structures in evaluation with a 

personal pc. The very most effective 

embedded systems are capable of 

performing fine a unmarried 

characteristic or set of talents to satisfy 

a unmarried predetermined motive. In 

extra complex structures an software 

program utility that permits the 

embedded machine to be used for a 

selected motive in a specific software 

determines the functioning of the 

embedded system.  
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MODERN USES OF THE HARVARD 

ARCHITECTURE: 

The principal advantage of the pure 

Harvard architecture - simultaneous access 

to more than one memory system - has 

been reduced by modified Harvard 

processors using modern CPU cache 

systems. Relatively pure Harvard 

architecture machines are used mostly in 

applications where tradeoffs, such as the 

cost and power savings from omitting 

caches, outweigh the programming 

penalties from having distinct code and 

data address spaces. 

 

VON-NEUMANN ARCHITECTURE 

A computer has a unmarried, common 

memory area in which each application 

instructions and facts are stored. There is a 

unmarried internal facts bus that fetches 

both instructions and records. They can't 

be finished at the identical time 

 
Figure 1 Schematic of the Von-

Neumann Architecture. 

Proposed Scheme 

 

OVERVIEW: ARDUINO UNO 

Arduino Uno is a microcontroller board 

based on 8-bit ATmega328P 

microcontroller. Along with ATmega328P, 

it consists other components such as 

crystal oscillator, serial communication, 

voltage regulator, etc. to support the 

microcontroller. Arduino Uno has 14 

digital input/output pins (out of which 6 

can be used as PWM outputs), 6 analog 

input pins, a USB connection, A Power 

barrel jack, an ICSP header and a reset 

button. 

 Serial Pins 0 (Rx) and 1 (Tx): Rx and 

Tx pins are used to receive and transmit 

TTL serial data. They are connected 

http://en.wikipedia.org/wiki/CPU_cache
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with the corresponding ATmega328P 

USB to TTL serial chip. 

 External Interrupt Pins 2 and 

3: These pins can be configured to 

trigger an interrupt on a low value, a 

rising or falling edge, or a change in 

value. 

 PWM Pins 3, 5, 6, 9 and 11: These 

pins provide an 8-bit PWM output by 

using analogWrite() function. 

 SPI Pins 10 (SS), 11 (MOSI), 12 

(MISO) and 13 (SCK): These pins are 

used for SPI communication. 

 In-built LED Pin 13: This pin is 

connected with an built-in LED, when 

pin 13 is HIGH – LED is on and when 

pin 13 is LOW, its off. 

 AREF: Used to provide reference 

voltage for analog inputs with 

analogReference() function. 

 Reset Pin: Making this pin LO 

 W, resets the microcontroller. 

2.1  Arduino Uno to ATmega328 Pin 

Mapping 

When ATmega328 chip is used in place of 

Arduino Uno, or vice versa, the image 

below shows the pin mapping between the 

two. 

 

SOFTWARE 

Arduino IDE (Integrated Development 

Environment) is required to program 

the Arduino Uno board. Download it 

here. 

 2.2 Programming Arduino 

// the setup function runs once when you 

press reset or power the board 

void setup() { 

  // initialize digital pin LED_BUILTIN as 

an output. 

  pinMode(LED_BUILTIN, OUTPUT); 

} 

 

// the loop function runs over and over 

again forever 

void loop() { 

  digitalWrite(LED_BUILTIN, HIGH);   // 

turn the LED on (HIGH is the voltage 

level) 

  delay(1000);                       // wait for a 

second 

  digitalWrite(LED_BUILTIN, LOW);    // 

turn the LED off by making the voltage 

LOW 

  delay(1000);                       // wait for a 

second 

https://www.arduino.cc/en/Main/Software
https://www.arduino.cc/en/Main/Software
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} 

 

 Applications 

 Prototyping of Electronics Products and 

Systems 

 Multiple DIY Projects. 

 Easy to use for beginner level DIYers 

and makers. 

 Projects requiring Multiple I/O 

interfaces and communications. 

2.3 ARDUINO IDE 

 you decided to go and buy yourself an 

Arduino, but once it arrived, you realized 

you have no idea what to do with it. Do 

not panic, for help is at hand! In this how-

to, we will look at how to get started with 

Arduino microcontroller boards. We’ll 

cover software installation, as well as 

connecting and configuring the Arduino 

IDE. 

You Will Need 

 Arduino Uno 

 USB B Cable 

 Windows 10, Windows 8, 

Windows 7, Mac, or Linux OS 

Be warned, the Arduino gained’t 

constantly be diagnosed automatically. If 

your Arduino is not recognized. Then 

uninstall the motive force, dispose of the 

Arduino, reinsert the Arduino, discover 

the unrecognized tool, right click on 

“Update motive force”, and then click 

“Search mechanically”. This should fix 

99 out of 100 problems.If the Arduino is 

not recognized, update the driver. 

 
Step 1: Configure the IDE 

Now that we have determined the COM 

port that the Arduino is on, it’s time to 

load the Arduino IDE and configure it to 

use the same device and port. Start by 

loading the IDE. Once it’s loaded, 

navigate to Tools > Board > Arduino 

Uno. However, if you are using a 

different board (i.e., not the Arduino 

Uno), you must select the proper board! 

Tell the IDE which board you are 

using. 

 

Next, you must tell the IDE which COM 

port the Arduino is on. To do this, 

navigate to Tools > Port > COM7. 

Obviously, if your Arduino is on a 

different port, select that port instead. 

 

 

 

 

https://www.digikey.in/product-detail/en/arduino/A000073/1050-1041-ND/3476357
https://www.digikey.in/product-detail/en/assmann-wsw-components/AK672-2-1-BLACK/AE10617-ND/2391696
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Step 2: Loading a Basic Example 

For the sake of simplicity, we will load an 

example project that the Arduino IDE 

comes with. This example will make the 

onboard LED blink for a second 

continuously. To load this example, click 

File > Examples > 01.Basics > Blink. 

Load the blink example.

 

With the instance loaded, it’s time to 

verify and upload the code. The verify 

level exams the code for mistakes, then 

compiles the geared up-for-uploading 

code to the Arduino. The upload degree 

absolutely takes the binary information, 

which changed into produced from the 

code, and uploads it to the Arduino thru 

the serial port. 

 
     While the capability impact of the IoT is 

enormous,   a concerted attempt is needed to 

move beyond this early degree. In order to 

optimise the development of the 

marketplace, a common information of the  

In summary, the IoT will require mobile 

networks to provide a miles greater 

different set of talents, at the same time as 

supplying protection mechanisms for 

identifying and blockading any application 

misbehaviour and making certain all 

different offerings. Mobile operators are 

running to identify those requirements and 

develop suitable talents so as to help the 

good sized range of IoT packages. 

 APPLICATIONS 

 Internet of Things enterprise region 

categories 

For customers, connectivity provided by 

the IoT could decorate their excellent of 

life in a couple of ways, together with, 

however no longer restrained to, energy 

efficiency and safety at home and inside 

the city. In the home, the mixing of linked 

clever devices and cloud-primarily based 

services will help cope with the pressing 
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issue of electricity efficiency and security. 

Connected clever devices will allow a 

reduction in software payments and 

outages, while additionally enhancing 

home safety through far off monitoring. 

 

 IOT CLEVER CITIES PROGRAMS 

In towns, the improvement of smart grids, 

statistics analytics and independent 

automobiles will provide an sensible 

platform to deliver improvements in 

electricity control, traffic management and 

protection, sharing the advantages of this 

technology in the course of society. 

 IOT HEALTH PROGRAMS 

The IoT can even assist widen get 

admission to and enhance nice of 

schooling and health. As demand for 

healthcare doubles8, linked smart devices 

will help deal with this assignment by way 

of supporting a range of e-health services 

that improve access and enable monitoring 

of chronic diseases and age-related 

conditions in the home. In doing so, they 

will improve the quality of care and 

quality of life for patients, while reducing 

the strain on the wider healthcare system. 

 IOT EDUCATION APPLICATIONS 

     training, cell-enabled 

solutions will tailor the learning manner to 

each scholar’s needs, enhancing general 

talent degrees, while linking virtual and 

physical lecture rooms to make studying 

extra convenient and on hand. Mobile 

education solutions have already been 

shown to improve rookies’ proficiency 

fees and reduce dropout quotes, and 

feature the ability to enable, by 2017, the 

schooling of up to one hundred eighty 

million additional students in developing 

countries who could be able to stay in 

faculty due to mEducation 

HARDWARE COMPONENTS 

This module includes a built-in USB 

port as well as a plethora of pin-outs. 

 

.  Specification: 

•  Voltage:3.3V. 

•  Wi-Fi Direct (P2P), soft-AP. 

•  Current consumption: 

10uA~170mA. 

•  Flash memory attachable: 16M B 

max (512K normal). 

•  Integrated TCP/IP protocol stack. 

•  Processor: Tensilica L106 32-bit. 

•  Processor speed: 80~160MHz. 

•  RAM: 32K + 80K. 

•  GPIOs: 17 (multiplexed with other 

functions). 

•  Analog to Digital: 1 input with 

1024 step resolution. 

•  +19.5dBm output power in 

802.11b mode 

•  802.11 support: b/g/n. 

•  Maximum concurrent TCP 

connections: 5. 

 

 PIN DEFINITION: 
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Install the ESP8266 Board Package 

Enter 

http://arduino.esp8266.com/stable/pack

age_esp8266com_index.json into 

Additional Board Manager URLs 

field in the Arduino v1.6.4+ preferences. 

BUZZER 

Nowadays, it's significantly more common 

to employ a ceramic-primarily based 

piezoelectric sounder, such as a Son 

warning, which emits a high-pitched tone. 

In game suggests it is also known as a 

"lockout device," because while one 

character signals ("buzzes in"), all others 

are locked out from signaling. Several 

game shows have large buzzer buttons that 

are diagnosed as "plungers". 

 
 PULSE SENSOR: 

Heart beat sensor is designed to give 

digital output of heat beat when a finger is 

placed on it. When the heart beat detector 

is working, the beat LED flashes in unison 

with each heart beat. This digital output 

can be connected to microcontroller 

directly to measure the Beats Per Minute 

(BPM) rate. It works on the principle of 

light modulation by blood flow through 

finger at each pulse.  

 

 

 

Applications 

 Digital Heart Rate monitor 

 Patient Monitoring System 

 Bio-Feedback control of robotics 

and applications 

Operating Voltage  +5V DC regulated  

Operating Current  100 mA  

Output Data Level  5V TTL level  

Heart Beat detection  Indicated  by LED 

and Output High Pulse Light source  

660nm Super Red LED  

Pin Details  

Board has 3-pin connector for using the 

sensor. Details are marked on PCB as 

below.  

Pin Name Details 

1  +5V  Power supply Positive input  

2  OUT  Active High output  

3  GND  Power supply Ground 2  

 
 HUMIDITY SENSOR: 

A sensor (additionally referred to as 

detectors) is a device that measures a 

measurable characteristic and converts it 

right into a signal which may be examine 

by an observer or by using an tool. For 

example, a mercury-in-glass thermometer 

converts the measured temperature into 

expansion and contraction of a liquid 

which may be study on a calibrated glass 

tube. A thermocouple converts 

temperature to an output voltage which 

may be study by means of a voltmeter.  

http://arduino.esp8266.com/stable/package_esp8266com_index.json
http://arduino.esp8266.com/stable/package_esp8266com_index.json
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Figure 2 Humidity sensor 

SENSOR:  

A sensor (also widely recognized as a 

detector) is a device that measures a 

measurable attribute and converts it into a 

signal that an observer or instrument can 

read. A mercury-in-glass thermometer, for 

example, converts measured temperature 

into liquid expansion and contraction, that 

can then be read on a calibrated glass tube. 

A thermocouple converts temperature to 

an output voltage that a voltmeter can 

read. 

TEMPERATURE SENSOR (LM35):  

Temperature sensor that converts 

temperature values into electrical signals. 

As a temperature sensor, we used an IC 

called the LM 35. The LM35 series 

sensors are precision integrated-circuit 

temperature sensors whose output voltage 

is proportional to the Celsius temperature. 

Because it is internally calibrated, the 

LM35 does not require external 

calibration. The LM35 requires no external 

calibration or trimming to achieve typical 

accuracies of 14°C at room temperature 

and 34°C over the entire 55 to +150°C 

temperature range..  

 

 

 

 

 

Features 

 Calibrated directly in ° Celsius 

(Centigrade) 

 Linear + 10.0 mV/°C scale factor 

 0.5°C accuracy guaranteed (at 

+25°C) 

 Rated for full −55° to +150°C 

range 

 Suitable for remote applications 

 Low cost due to wafer-level 

trimming 

 Operates from 4 to 30 volts 

 Less than 60 μA current drain 

 Low self-heating, 0.08°C in still air 

 Nonlinearity only ±1⁄4°C typical 

 Low impedance output, 0.1 W for 

1 mA load 

LM35: 

 LM35 is precision integrated 

circuit temperature sensor. Its 

output voltage is linearly 

proportional to temperature(in 

celsius). 

 The LM35 thus has 

anadvantage over linear 

temperature sensors calibrated 

in° Kelvin, as the user is not 

required to subtract a large 

constant voltage from its output 

to obtain convenient Centigrade 

scaling. The LM35 does not 

require any external calibration 

or trimming to provide typical 

accuracies of ±1⁄4°C at room 

temperature and ±3⁄4°C over a 

full −55 to +150°C temperature 

range 
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Construction of Synchronous Motor 

 
Figure 3 Synchronous motor 

Its construction is almost identical to that 

of a three-phase induction motor, except 

that the rotor is powered by a direct 

current supply, for reasons that will be 

explained later. Let us first go over the 

fundamental design of this type of motor. 

It's indeed clear from the above image how 

these types of motors are designed. The 

stator receives three phase power, while 

the rotor receives direct current 

power.humming noise and can prevent 

motor stalling. 

  MOTOR DRIVER 

 

The L293D embedded device is a dual H-

bridge motor driver (IC). Because they 

take a low-current signal and provide a 

greater signal, servomotors function as 

current amplifiers. The motors have been 

driven through this higher current signal. 

L293D includes two H-bridge driver 

circuits. Two DC motors can be driven 

simultaneously in both forward and 

backward direction in its common mode of 

operation. Input logic at pins 2 and 7 and 

10 and 15 can control the motor operations 

of two motors. Input logic 00 or 11 will 

cause the corresponding motor to stop. 

Logic 01 and 10 will rotate it clockwise 

and anticlockwise, respectively. To start 

the motors, enable pins 1 and 9 

(corresponding to the two motors) must be 

high.  

 

 
Figure 4 MOTOR 

Pin Diagram:  

 
Figure 5 PIN DIAGRAM 

Pin Description:  
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 ADVANTAGES  

 Decreased field 

damaging conditions 

 Improved safety and 

security 

 High quality receiving 

data 

 Less power 

consumption 

 High speed data rate 

ULTRASONIC DISTANCE 

MESURMENT 

This Rhydolabz "Resonance" Ultrasonic 

Range Detector is a fantastic product that 

provides detection and ranging from very 

close (2CM) to very far (4M). The sensor 

provides highly accurate non-contact 

distance measurements ranging from 2cm 

to 4 metres. Its small size, extended range, 

and ease of use make it an excellent sensor 

for distance measurement and mapping. 

The board is easily interfaced to 

microcontrollers, with triggering and 

measurement performed on a single I/O 

pin. The sensor sends out an ultrasonic 

wave and generates an output pulse equal 

to the time it takes for the burst echo to 

return to the sensor. The distance to the 

target can be easily calculated by 

measuring the width of a echo pulse. 

 
Figure 6 ECHO SENSORS 

ECHO SENSOR FEATURES 

• Professional EMI/RFI Complaint 

PCB Layout Design for Noise Reduction 

• Range : 2 cm to 4 m 

• Accurate and Stable range data 

• Data loss in Error zone eliminated 

• Modulation at 40 KHz 

• Mounting holes provided on the 

circuit board 

• Triggered externally by supplying a 

pulse to the signal pin 

• 5V DC Supply voltage 

• Current - < 20mA 

• Bidirectional TTL pulse interface 

on a single I/O pin can communicate with 

5 V TTL or 3.3V CMOS microcontrollers 

• Echo pulse: positive TTL pulse, 87 

^s minimum to 30 ms maximum(PWM) 

• On Board Burst LED Indicator 

shows measurement in progress 

• 3-pin header makes it easy to 

connect using a servo extension cable, no 

soldering required 

 FINDING THE DISTANCE 

The ECHO sensor emits a short 40 kHz 

(ultrasonic) wave underneath the control of 

a host micro - controller (trigger pulse). 

This burst travels through the air, collides 

with an object, and then returns to the 

sensor. When an echo is discovered, the 

ECHO sensor will send an output pulse to 

the host (via its signal pin), and the width 

of this pulse can be used to quantify the 
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distance to the target

 
PRACTICAL CONSIDERATION FOR 

USE 

- Object Positioning 

The ECHO sensor cannot accurately 

measure the distance to an object that: 

• Is more than 4 meters away, Fig 1 

• That has its reflective surface at a 

shallow angle so that sound will not be 

reflected back towards the sensor (Angle 0 

< 90°), Fig 2. or 

• Is too small to reflect enough 

sound back to the sensor. 

In addition, if your ECHO sensor is 

mounted low on your device, you may 

detect sound reflecting off the floor. 

Ideal Case Of Positioning Error Case 

 

Figure 7 Target Object Material 

Furthermore, objects that absorb sound or 

have a soft or irregular surface, such as a 

stuffed animal, may not reflect enough 

sound to be accurately detected. The 

ECHO sensor detects the surface of water, 

but it is not designed for outdoor use or 

continuous use in wet conditions. 

Condensation on its transducers may have 

an impact on the device's achievement as 

well as lifespan.. 

BLUE TOOTH 

 BLUETOOTH 

           Bluetooth is an open wireless 

technology standard for exchanging data 

over short distances (via short wavelength 

radio transmissions) between fixed and 

mobile devices, resulting in highly secure 

personal area networks (PANs). It was 

established in 1994 by telecom seller 

Ericsson as a wireless alternative to RS-

232 data cables. It can connect multiple 

devices, overcoming syncing issues. 

 Bluetooth Overview 

Why Bluetooth? 

Bluetooth is a short-range radio link that is 

designed to replace the cable(s) that 

connect  

Bluetooth has a much lower data rate and 

transmitting variety than HomeRF and the 

IEEE 802.11 family (10 meter). While 

HomeRF supports a bit rate of 1.6 10 

Mbps and IEEE 802.11a/b supports 54/11 

Mbps, Bluetooth only supports 780 Kbps, 

which can be used for 721 kbps 

downstream aand upstream asymmetric 
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data transfer at 57.6 kbps or symmetric 

data transfer at 432.6 kbps. HomeRF and I 

both11 have a range of 100 metres, 

whereas Bluetooth has a range of 10 

metres. 

Bluetooth, on the other hand, has a much 

cheaper price per node due to the reduced 

data rate as well as produce different 

results (approximately 5% of HomeRF and 

IEEE 802.11). As a result, it is better 

suited for applications that require a low 

data rate (data and voice), a tiny minority 

of devices (8 at most), low power 

consumption, and a short range (up to 10 

metres), such as PC-to-peripheral 

networking, home networking, hidden 

computing, data synchronisation (such as 

between PC and PDA), mobile phone 

devices, and future smart devices or 

entertainment equipment. 

 BLUETOOTH ARCHITECTURE 

The Bluetooth architecture and its 

relationship to the OSI model 

Bluetooth communication takes place 

between a master and a slave radio. 

Bluetooth radios are symmetric inside the 

context that a single device can function as 

both a master and a slave. Each radio has a 

fixed 48-bit device address (BD ADDR).. 

A Bluetooth network connection can only 

be initiated by a master. Once a link is 

established, however, the slave may 

request a master/slave switch to become 

the master. Slaves are not permitted to 

communicate directly with one another. 

All communication takes place between 

the slave and the master. Within a piconet, 

slaves  

 

Figure 8  Bluetooth Scatternets and 

Piconets 

A scatternet is made up of multiple 

piconets with overlapping coverage areas. 

Each piconet can have only one master, 

but slaves can participate in multiple 

piconets at the same time. A device can be 

a master in one piconet and a slave in 

another, or it can be a slave in multiple 

piconets. 

 Bluetooth Topology 

There can be only 2 ~ 8 Bluetooth devices 

talking to each other. This is called a 

piconet. Among these devices, there can 

be only one master device, all the rest are 

slave devices. A device can belong to two 

piconets meantime, serving as slaves in 

both piconet or a master in one and slave 

in another. This is called a bridging device. 

Bridging devices connect piconets together 

to form a scatternet:

 
Figure 9  Single-slave piconet (a), 

multiple-slave piconet and scatternet (c) 
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RF AND BASEBAND 

Bluetooth operates in the 2.5GHz 

Industrial-Scientific-Medical (ISM) band, 

which is unlicensed.There are already 

many types of devices using this band, 

such as baby monitors and garage door 

remote controls. TBluetooth devices send 

out very weak signals to avoid interfering 

with these devices (about 1 milliwatt). The 

transmission range is thus limited to 10 

metres.  

MODULATION 

The modulation in Bluetooth is Gaussian 

Frequency Shift Keying (GFSK), with BT 

= 0.5 and modulation index between 0.25 

and 0.35: 

 

Figure 9 MODULATION 

BLUETOOTH MODULATION 

(GFSK) 

PHYSICAL LINKS 

Bluetooth protocol uses a combination of 

synchronous and asynchronous links. A 

Synchronous Connection-Oriented (SCO) 

link is a point-to-point link between the 

master and specific slave. It has symmetric 

64 kbps rate, typically used for voice 

transmission. It uses reserved time slots, 

thus can be regarded as a circuit switching 

link. A master can support up to 3 SCO 

links to one or multiple slaves, while a 

slave can support up to three SCO links to 

one master or up to two SCO links to 

different masters. Master transmits at 

reserved master-to-slave time slot, and 

slave response in the following slave-to-

master slot. SCO packets are never 

retransmitted. Bluetooth protocol employs 

both synchronous and asynchronous links. 

A point-to-point Synchronous Connection-

Oriented (SCO) link connects the master 

and a specific slave. It has a symmetric 64 

kbps rate, which is typical for voice 

transmission. It uses reserved time slots 

and thus functions as a circuit switching 

link. A slave can also have up to three 

SCO links to one or even more masters, 

while a master can have up to three SCO 

links to one master or up to two SCO 

connections to various masters. The 

maestro transmits during the reserved 

master-to-slave time slot, and the slave 

reacts during the following slave-to-master 

time slot. SCO packets are never resent 

 PACKET FORMAT 

Data in piconet is encoded in packets. The 

general packet format is shown below: 

  

 
Figure 10 General Packet Format of 

Bluetooth 
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Specifications:  

Pin 
Symbol Level Function 

1 VSS - Power, GND 

2 VDD - Power, 5V 

3 Vo - 
Power, for LCD 

Drive 

4 RS H/L 

Register Select 

Signal 

H: Data Input 

L: Instruction Input 

5 R/W H/L 

H: Data Read (LCD-

>MPU) 

L: Data Write (MPU-

>LCD) 

6 E 
H,H-

>L 
Enable 

7-14 
DB0-

DB7 
H/L 

Data Bus; Software 

selectable 4- or 8-bit 

mode 

15 NC - 
NOT 

CONNECTED 

16 NC - 
NOT 

CONNECTED 

Even when limited to character-based 

modules, a wide range of shapes and sizes 

are available. Standard line lengths are 8, 

16, 20, 24, 32, and 40 characters in one, 

two, and four line versions. 

 
Figure 11 Pin specifications 

Fixed readers are configured to create a 

tightly controlled interrogation zone. This 

allows for a well-defined reading area 

when tags enter and exit the interrogation 

zone. Mobile readers can be held in one's 

hand or mounted on carts or vehicles. 

 

Figure 12 READER MODULE 

Bulk reading 

Bulk reading is a strategy for interrogating 

multiple tags at once, but it lacks the 

precision required for inventory control. A 

group of RFID-tagged objects is read 

entirely from a single reader position at the 

same time. Rfid labels with HF (ISO 

18000-3), UHF (ISO 18000-6), and SHF 

(ISO 18000-4) frequencies may be used 

for bulk reading. However, because tags 

respond sequentially, the time required for 

bulk reading increases linearly with the 
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number of labels to be read. This means 

that reading twice as many labels takes at 

least two times as long. The time required 

is increased due to collision effects...
[citation 

needed]
 

Electronic key for RFID based lock system 

SOFTWARE IMPLEMENTATION 

Arduino Uno on the Arduino Desktop IDE 

If you want to programme your Arduino 

Uno while not connected to the internet, 

you must first instal the Arduino Desktop 

IDE. The Arduino Software (IDE), our 

Integrated Development Environment that 

is shared by all of our boards, is used to 

programme the Uno. Before proceeding, 

you must have installed the Arduino 

Software (IDE) on your PC, as described 

on the home page of our Getting Started 

section. Connect your Uno board to a 

computer using an A B USB cable, also 

known as a USB printer cable. 

 
Figure 12  Select the board driver 

CONCLUSION 

Robotics play a significant part in the 

global economy and everyday life. 

Another challenge of robotics research is 

to be successful and to develop patents 

according to the complexity of their 

applications for global industries. The 

market for robotics technology is rising in 

a wide variety of applications and human 

activities, particularly for the 

manufacturing, medical, utility, defense 

and consumer industries. This Bluetooth 

control and obstacle with edge detecting 

robot is the prototype of robots for 

industrial use. This smart and intelligent 

robot has more benefits because it doesn't 

consume much power. Our project aims at 

creating an autonomous robot that 

intelligently senses the obstacle and the 

edge in its path. So, what this system 

provides is an alternative to the existing 

system by replacing skilled labor with 

robotic machinery, which in turn can 

handle more patients in less time with 

better accuracy and a lower cost. 

Performance can be improved by using 

good materials and great sensing power 

also improves motor movement. The setup 

cost of the Bluetooth control robot 

depends primarily on the costly 

machinery, property, and building and 

staff around the clock to maintain and use 

the machinery.  

REFERENCES 

[1] "Line Follower Robot," Cao Quoc 

Huy, University UPG din Ploiesti. 

[2]  Md Mamunur Rashidc, Nakib Hayat, 

Deloara Khushib, and Chowdhurya. 

"Algorithm for line follower robots to 

follow critical paths with the fewest 

sensors." International Journal of 

Computer, Volume 24, Number 1 (2017), 

pp. 13-22.  

[3] "Line follower robot: Fabrication and 

accuracy measurement by data 

acquisition," F. Kaiser, S. Islam, W. 

Imran, K. H. Khan, and K. M. A. Islam, 

2014 International Conference on 

Electrical Engineering and Information 

&Communication Technology, Dhaka, pp. 

1-6 

https://en.wikipedia.org/wiki/Wikipedia:Citation_needed
https://en.wikipedia.org/wiki/Wikipedia:Citation_needed


IJFANS INTERNATIONAL JOURNAL OF FOOD AND NUTRITIONAL SCIENCES 

ISSN PRINT 2319 1775 Online 2320 7876 

Research paper© 2012 IJFANS. All Rights Reserved, Journal Volume 10, Iss 10, 2021 

412 
 

[4] A comparative study of gas explosion 

occurrences and causes in China and the 

United States, Gao Y., Fu G., Nieto A. 

International Journal of Mine Reclamation 

and Environment 2015; 30:269-278. doi: 

10.1080/17480930.2015.1043770. 

[5] "Autonomous colour line follower 

robot with obstacle avoidance based on 

sensors," Mr. K. M. Hasan" K. M. Hasan, 

A. Al-Nahid, K. J. Reza, S. Khatun, and 

M. R. Basar, 2013 IEEE Business 

Engineering and Industrial Applications 

Colloquium (BEIAC), Langkawi, 2013, 

pp. 598-603. 

[6] Kahe (2007), "AVR Microcontroller," 

Nas Publication  

[7] L. Kasprzyczak, S. Trenczek, and M. 

Cader developed a mechatronic product 

for tracking hazardous surroundings. 6:57-

64 in J. Autom. Mob. Robot. Intell. Syst. 

[8] "Design and implementation of RFID 

line-follower robot system with colour 

detection capability using fuzzy logic," 

2015 International Conference on Control, 

Electronics,Renewable Energy and 

Communications (ICCEREC), Bandung, 

pp. 75-78...  


